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Klíčová slova 
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zdokonalený výškopis, výškový systém ČR. 

 

Abstrakt 

Předmětem diplomové práce je porovnání výškopisu ZABAGED a zdokonaleného výškopisu 

ZABAGED s daty leteckého laserového skenování, zhodnocení účinnosti zpřesnění 

výškopisu ZABAGED. Nakonec je zkoumána možnost využití nivelačních bodů pro kontrolu 

přesnosti výšek bodů leteckého laserového skenování. 

 

Key words 

Aerial laser scanning, DTM ZABAGED, ZABAGED - altimetry, ZABAGED - altimetry 

improved, vertical datum ČR. 

 

Abstract 

The object of this diploma thesis is a comparison altimetry ZABAGED and altimetry 

improved ZABAGED with data of aerial laser scanning, a evaluation usefull more accurate 

ZABAGED. Finally is studied possibility of using leveling points for control accuracy of the 

heights points of aerial laser scanning. 
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1. Úvod 

Digitální modely terénu jsou využívány v oblasti zabezpečení státu, v oblasti krizového 

řízení, v aplikacích moderních řídících a bezpečnostních systémů v letectví, pro tvorbu 

územně analytických podkladů, pro aplikace moderních metod geologického průzkumu               

a projektování na úseku povrchového důlního hospodářství i pro řešení a zpracování studií          

a plánovacích dokumentací na úseku ochrany životního prostředí. Digitální modely terénu 

jsou potřebné v oblasti ochrany povrchových i podzemních vod, pro aplikace 

automatizovaných metod analýz terénu v oblasti řízení a ochrany zemědělské půdy i v oblasti 

správy lesního půdního fondu a lesů, atd. Všechny současné digitální modely reliéfu však 

mají nedostatečnou přesnost a vysokou míru generalizace. Interpolace objektů mikroreliéfu 

tak nedosahuje požadované přesnosti. Na území České republiky v současné době existují tři 

druhy dat - ZABAGED - výškopis, ZABAGED - zdokonalený výškopis a od roku 2010 data 

leteckého laserového skenování (LLS). Metoda leteckého laserového skenování je používána 

v Projektu tvorby nového výškopisu ČR, který je zaměřen na získávání kvalitních 

výškopisných dat z celého území ČR. 

Protože kvalita výškopisných dat je klíčovým faktorem ovlivňující rozsah jejich 

použitelnosti, je cílem této diplomové práce ověření účinnost zpřesnění digitálního modelu 

reliéfu Základní báze geografických dat (DMR ZABAGED) v zastavěném území města 

Plzně. Tato diplomová práce navazuje na několik diplomových prací, které se v minulosti 

kvalitou výškopisu ZABAGED zabývaly, a doplňuje je o hodnocení v zastavěném území 

města. Ověření účinnosti zpřesnění je provedeno porovnáním zdokonaleného DMR 

ZABAGED s původním a také porovnáním DMR ZABAGED zdokonaleného a původního 

s daty leteckého laserového skenování (LLS). Posledním výstupem je získání výškových 

rozdílů a parametrů přesnosti dat LLS v blízkém okolí nivelačních bodů. 
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2. ZABAGED, LLS a výškové systémy ČR  

Kapitola obsahuje stručný popis vlastností a historii dat použitých v této diplomové práci, tj. 

data ZABAGED, data leteckého laserového skenování (LLS) pořízená v Projektu tvorby 

nového výškopisu území ČR a údaje o nivelačních bodech výškového bodového pole. 

2.1 ZABAGED, DMR ZABAGED 

Základní báze geografických dat (ZABAGED) je digitální vektorový geografický model 

území České republiky, který spravuje Zeměměřický úřad [14]. 

2.1.1 Stručně o ZABAGED 

Počátkem 90. let 20. století vydala bývalá Komise vlády pro státní informační systém 

usnesení, které zadalo tehdejšímu Českému úřadu geodetickému a kartografickému (ČÚGK - 

dnes ČÚZK) zpracovat projekt ZABAGED jako součást informačního systému ČR. V roce 

1995 započal proces tvorby ZABAGED vektorizací tiskových podkladů ZM 10. ZABAGED 

byla naplněna v roce 2004 v celém rozsahu území ČR včetně nadefinování objektů. První 

aktualizace a zpřesnění polohy objektů proběhlo v letech 2000 až 2005 pomocí 

fotogrammetrických metod a terénního šetření. Druhý cyklus aktualizace se realizoval            

v letech 2006 až 2009. Následně byl zahájen třetí cyklus. Perioda aktualizace se postupně 

zkracovala až na tříletou. Vytváření a následné využití leteckých měřických snímků                

a barevných ortofot probíhá každoročně pro jednu třetinu území [3], [14]. 

Na celém území ČR byla v roce 2009 zastavena kontrola a aktualizace 3D vrstevnic 

fotogrammetrickými metodami. Došlo k vytvoření nového digitálního modelu reliéfu pro celé 

území ČR. Model má strukturu pravidelné mříže 10 x 10 m trojrozměrně vedených (3D) 

bodů [14]. 

Prostorová data ZABAGED jsou vedena v souřadnicovém systému jednotné trigonometrické 

sítě katastrální (S-JTSK) a výškovém systému Balt po vyrovnání (Bpv). Pořizování a údržba 

dat spadá do působnosti resortu Českého úřadu zeměměřického a katastrálního (ČÚZK), [3]. 

V současné době ZABAGED obsahuje 123 typů geografických objektů, které jsou rozděleny 

do polohopisné a výškopisné složky. Prostorové (dvourozměrné) a popisné informace             

o komunikacích, sídlech, vodstvu, rozvodných sítí a produktovodech, vegetaci a povrchu, 

terénním reliéfu, územních jednotkách a chráněných území obsahuje polohopisná část 

ZABAGED. Do této části spadají i údaje o vybraných geodetických bodech [14]. 
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Výškopisnou složku ZABAGED tvoří body mřížky, břehovky, dolní hrany, horní hrany, 

koruny železničních těles, kótované body, mosty, potoky, profily a tři typy objektů vrstevnic. 

V závislosti na charakteru terénu mají vrstevnice základní interval 5, 2 nebo 1 m. Obsah 

datové sady ZABAGED - výškopis - 3D vrstevnice je doplněn výškopisnými prvky 

(klasifikovanými hranami a body). Při zpřesňování vrstevnicového výškopisu byly tyto prvky 

vyhodnoceny stereofotogrammetrickou metodou. Všechny objekty jsou reprezentovány 

trojrozměrnou vektorovou prostorovou složkou. Výškopis je průběžně aktualizován tzv. 

zpřesněným modelem [14]. 

V geografických informačních systémech je ZABAGED využívána jako základní vrstva, 

především v informačních systémech veřejné správy. Dále je využívána jako hlavní datový 

zdroj pro tvorbu základních map ČR v měřítkách 1: 10 000 až 1: 100 000. Výstup z databáze 

Geonames je vhodným doplněním dat ZABAGED [14]. 

2.1.2 DMR ZABAGED, DMR v resortu Ministerstva obrany ČR a jejich technické 

parametry 

Digitální model reliéfu (DMR), digitální model terénu (DMT), anglicky digital terrain model 

(DTM) je podle [13] „digitální reprezentace zemského povrchu v paměti počítače, složená       

z dat a interpolačního algoritmu, který umožňuje mj. odvozovat výšky mezilehlých bodů“. 

Digitální model reliéfu (DMR) je podle [6] „digitální zobrazení přirozeného nebo lidskou 

činností upraveného zemského povrchu formou výšek diskrétních bodů v pravidelné nebo 

nepravidelné síti nebo pomocí vrstevnic a terénních hran“. Jde tedy o model přirozeně nebo 

lidskou činností vzniklého zemského povrchu bez staveb a vegetace. 

Digitální model povrchu (DMP) je podle [6] „digitální zobrazení zemského povrchu včetně 

vertikálních geografických objektů (budov a jiných pozemních staveb, mostů, hrází, lesů 

apod.) formou výšek diskrétních bodů v pravidelné nebo nepravidelné síti pomocí vrstevnic   

a hran objektů“. 

Datová sada ZABAGED - výškopis má výškopisná data reprezentována objekty vrstevnic       

s příslušnou výškou. Tento model obsahuje digitalizované vrstevnice, které byly získány 

digitalizací výškopisu ZM10. Z velké části vrstevnice pocházejí z původního topografického 

mapování území ČR v měřítku 1: 10 000, jehož realizace proběhla převážně metodou letecké 

stereofotogrammetrie v letech 1957 až 1965. Po roce 1968 byly vrstevnice ze souřadnicového 

referenčního systému S-42 blokově transformovány a převedeny do souřadnicového 
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referenčního systému JTSK. Přestože byl odvozený výškopis aktualizován, došlo k přenášení 

řady chyb, postupnému zastarávání dat a ke snížení homogenity tohoto výškového modelu 

území ČR. Model ZABAGED - výškopis pokrývá celé území ČR. Je spravován 

Zeměměřickým úřadem (ZÚ) v resortu ČÚZK [6]. 

Datová sada ZABAGED - zdokonalený výškopis vzniká od roku 2005. Pokrývá celé území 

ČR a je také spravována ZÚ v resortu ČÚZK. Jedná se o aktualizovaný model ZABAGED - 

výškopis, kde jsou zjišťovány změny pomocí analytické a digitální fotogrammetrie. Probíhá     

i doměřování výrazných terénních hran náspů, výkopů, břehů řek, nádrží, těžebních lokalit 

atd. I přesto se nepodařilo odstranit nehomogenitu výškopisu ZABAGED ani zásadně 

zpřesnit jeho výškové údaje tak, aby vyhovovaly současným požadavkům uživatelů [6]. 

Datová sada ZABAGED - výškopis ve formě mříže 10 x 10 m je spravována ZÚ v resortu 

ČÚZK. Jde o alternativní zobrazení ZABAGED - zdokonalený výškopis. Tento model má 

formu georeferencovaných souborů GRID s výškovými kótami ve čtvercové síti bodů. Model 

vzniká v rámci periodické tvorby ortofotografického zobrazení celého území ČR v tříletém 

intervalu především pro potřeby ortogonalizace leteckých měřických snímků [6]. 

Digitální model reliéfu dvouapůlté generace pokrývá celé území České republiky a je 

spravován Vojenským geografickým a hydrometeorologickým úřadem (VGHMÚř) v resortu 

Ministerstva obrany České republiky. Je reprezentován pravidelnou sítí výškových bodů    

100 x 100 m. Původně měl tento model sloužit pro potřeby vojsk československé armády. 

Model byl vytvářen od roku 1979. Vycházel z již zastaralých topografických map měřítka     

1: 10 000. Následně byl zdokonalován. Tento model již dnes nestačí požadavkům armády, 

orgánů státní správy ani územní samosprávy, protože má nižší přesnost v interpolaci výšek 

[6]. 

Digitální model reliéfu třetí generace byl vytvářen v letech 2003 až 2009 v resortu 

Ministerstva obrany ČR ve VGHMÚř. Je spravován VGHMÚř a pokrývá celé území ČR. 

Cílem bylo vytvořit přesnější digitální výškopisný model především pro potřeby 

ortogonalizace leteckých měřických snímků v měřítku 1: 23 000. DMR vznikal 

stereofotogrammetrickým měřením a byl prvotně uložen ve formě nepravidelné 

trojúhelníkové sítě TIN (Triangular Irregual Network), [6]. 
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Tabulka 2.1. Závěry hodnocení výškopisných modelů ČR - převzato z [6] 
 

Název databáze Obsah Střední chyba výšky 

ZABAGED - výškopis Vektorizované vrstevnice ZM 10 

uložené jako 3D objekty ve formátu 

DGN. 

0,7 - 1,5 m v odkrytém 

terénu  

1 - 2 m v intravilánech  

2 - 5 m v zalesněných 

územích 

ZABAGED - zdokonalený 

výškopis 

Automatizované a zpřesněné 

vrstevnice ZM 10, doplněné o 

terénní hrany náspů, výkopů, břehů, 

nádrží apod. 

0,7 - 1,5 m v odkrytém 

terénu, 

1 - 2 m v intravilánech  

2 - 5 m v zalesněných 

územích 

ZABAGED - mříž 10 x 10 

m 

Odvozený model z databáze 

ZABAGED - zdokonalený výškopis 

do formy mříže (GRID) 10 x 10 m 

1,5 - 2,5 m v odkrytém 

terénu 

2 - 3 m v intravilánech  

3 - 7 m v zalesněných 

územích 

DMR 2,5. generace 

Ministerstva obrany ČR 

Výškový model ve formě mříže 

(GRID) 100 x 100 m 

3 - 5 m v odkrytém terénu  

5 - 8 m v intravilánech  

10 - 15 m v zalesněných 

územích 

DMR 3. generace 

Ministerstva obrany ČR 

Výškový model ve formě 

nepravidelné sítě TIN získaný 

stereofotogammetrickou metodou 

1 - 2 m v odkrytém terénu  

1 - 2 m v intravilánech  

3 - 7 m v zalesněných 

územích 

Všechny současné DMR mají nedostatečnou přesnost a vysokou míru generalizace. 

Interpolace objektů mikroreliéfu tak nedosahuje požadované přesnosti. Závěry hodnocení 

výškopisných modelů ČR jsou uvedeny v tab. 2.1. Tato situace vede k omezenému používání 

automatizovaných úloh modelování obrany státu, k nedostatečnému modelování živelných 

katastrof a průmyslových havárií, k omezení moderních řídících a bezpečnostních systémů          

v letectví. Dále jsou DMR nedostačující pro tvorbu územně analytických podkladů, pro 

aplikaci moderních metod geologického průzkumu povrchového a důlního hospodářství, pro 

řešení a zpracování studií na úseku ochrany životního prostředí, pro modelování v oblasti 

ochrany povrchových a podzemních vod. Také je omezena aplikace automatizovaných metod 

analýz terénu v oblasti řízení a ochrany zemědělské půdy, v oblasti správy lesního půdního 

fondu a lesů i v oblasti rozvoje rádiové komunikační infrastruktury na území ČR [6]. 

Tvorba věrných ortofotomap, státních mapových děl a geografických databází velkého 

měřítka je omezena přesností a hustotou DMR a neexistencí kvalitního DMP. Dále se             
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v příhraničích oblastech omezuje úroveň mezinárodní spolupráce a tvorba společných 

mezinárodních projektů ochrany a rozvoje příhraničních oblastí [6]. 

Výše uvedený výčet poukazuje stále na neexistující výškopisný produkt celostátního rozsahu, 

který by byl uspokojivý pro všechny oblasti rozvoje státu. Došlo se k Projektu nového 

mapování výškopisu ČR, kde je aplikovaná metoda leteckého laserového skenování (LLS). 

2.2 Letecké laserové skenování 

Kvalitní výškopisná data z celého území ČR jsou vyžadována především orgány, 

organizacemi a útvary ministerstev ČR. Proto byl v roce 2009 zahájen projekt vyhotovení 

nového, výrazně přesnějšího výškopisu na celém území České republiky ve formě digitálního 

modelu reliéfu (DMR 4G, DMR 5G) a digitálního modelu povrchu včetně lesních porostů      

a staveb (DMP 1G). Před formulací návrhu a rozběhnutím projektu byla diskutována různá 

řešení. Mezi možnostmi se objevila např. digitální stereofotogrammetrie nebo letecké 

laserové skenování (LLS). Byla zvolena metoda leteckého laserového skenování pro svou 

ekonomickou a produkční efektivnost, vysokou hustotu výškových bodů i výškovou přesnost 

odpovídající současným požadavkům uživatelů geografických informací v České republice 

[6], [7]. 

Nové výškopisné modely umožní např. výpočty objemů srážek a odtoků z povodí i přesné 

vymezení záplavových území, rozvoj a uplatnění simulačních technologií a trenažérové 

techniky při výcviku štábu a vojsk Armády ČR. Také poskytnou jeden z nejdůležitějších 

územně - analytických podkladů plánování a projektování výstavby v působnosti např. 

Ministerstva pro místní rozvoj ČR nebo Ministerstva resortu dopravy ČR [6]. 

Soubory výškových bodů o hustotě 1 bod/m
2
 se střední chybou měření délky prostorového 

rajonu do 0,10 m budou výsledným produktem vlastního skenování. Tyto požadavky splňuje 

realizace LLS ze střední výšky od 1200 do 1500 m nad terénem s překrytem sousedních 

skenovacích pásů 40 - 50 % [6]. 

Digitálního modelu reliéfu území ČR 4. generace (DMR 4G) má formu mříže 5 x 5 m. 

Výsledek předběžného automatizovaného zpracování počítá s úplnou střední chybou výšky 

0,30 m v odkrytém terénu a 1 m v zalesněném terénu. Model je vytvářen na území ČR ve 

třech pásmech. Termín dokončení je plánovaný na konec roku 2012 [6]. 

Digitálního modelu reliéfu území ČR 5. generace (DMR 5G) má formu nepravidelné 

trojúhelníkové sítě bodů (TIN). Finální poloautomatické zpracování dat počítá s úplnou 
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střední chybou výšky 0,18 m v odkrytém terénu a 0,30 m v zalesněném terénu. Model bude 

vytvářen po ukončení snímkování celého ČR (r. 2012). Termín dokončení je plánován na 

konec roku 2015 [6]. 

Posledním výstupem je digitální model povrchu území ČR 1. generace (DPM 1G) ve formě 

nepravidelné trojúhelníkové sítě bodů (TIN). TIN by měla mít úplnou střední chybu výšky 

0,4 m pro přesně vymezené objekty a 0,7 m pro objekty přesně neohraničené (např. lesy          

a místa  s rostlinným půdním pokryvem). Termín zahájení je také naplánován po ukončení 

skenování celého území ČR (r. 2012) a termín dokončení na rok 2015 [6]. 

Všechny tři výše uvedené produkty budou zpracovány v souřadnicových referenčních 

systémech WGS 84 a JTSK a v Baltském výškovém systému po vyrovnání. Dohoda               

o spolupráci při tvorbě digitálních databází výškopisu území České republiky zajišťuje mezi 

Ministerstvem zemědělství ČR, Ministerstvem obrany ČR a ČÚZK plnění projektu. ČÚZK 

organizuje spolupráci, zajišťuje projektovou přípravu LLS a zpracování laserových dat           

v rozsahu 3/4 území ČR. Ministerstvo zemědělství ČR se podílí na financování pronájmu 

leteckého laserového skeneru. Ministerstvo obrany ČR se podílí na přípravě technologií pro 

zpracování dat LLS, zajišťuje realizaci LLS letadly typu L 410 FG a svými odbornými 

kapacitami [6]. 

2.2.1 Historie leteckého laserového skenování 

Pokud jde o získávání aktuálních geoprostorových dat pokrývajících celé území ČR, stal se 

důležitým historickým mezníkem rok 2010, kdy bylo zahájeno LLS. Digitální letecké 

měřické snímkování v barevném (RGB) a blízkém infračerveném (NIR) pásmu spektra bylo 

realizováno na 36 % území České republiky. Cílem bylo vytvořit databanku v rámci 

dlouhodobého projektu periodického leteckého měřického snímkování s rozlišením 0,20 m. 

Také bylo vytvářeno digitální barevné ortografické zobrazení celého území ČR s rozlišením 

0,25 m. Toto v zásadě ukončilo dosavadní letecké měřické snímkování na film, které bylo 

následně přesně skenováno do rastrové formy potřebné pro další počítačové zpracování. Ve 

stejné době bylo úspěšně realizováno LLS na přibližně 42 % území ČR v rámci Projektu 

tvorby nového výškopisu území České republiky [5]. LLS se tedy stává novou metodou 

požívanou na území ČR nahrazující předešlé dlouho používané postupy a metody k získávání 

výškopisných dat. 

Dosavadní výškopis získaný „klasickými metodami“ a pokrývající celou Českou republiku je 
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součástí Základní mapy ČR 1: 10 000. Představuje grafický vrstevnicový model se základním 

intervalem vrstevnic 2 m. Tento model byl digitalizován do vektorové formy v rámci tvorby 

ZABAGED (DMR ZABAGED - výškopis) v letech 1995 - 2000. Velký počet hrubých chyb 

a nehomogenita vedly v roce 2008 ke zpracování Projektu tvorby nového výškopisu celého 

území ČR, který je do současné doby stále tvořen LLS. Letové dráhy pro LMS byly 

rovnoběžné s osou Y souřadnicového referenčního systému JTSK, přičemž bloky i plány 

letových drah LLS jsou voleny v závislosti na souřadnicovém referenčním systému 

UTM/WGS 84. V závislosti na výškové členitosti georeliéfu mají bloky rozměry 10 x 10 km, 

10 x 20 km a 10 x 30 km [5]. 

2.2.2 Princip a technické parametry leteckého laserového skenování 

Základním předpokladem pro dosažení požadovaných parametrů výsledků měření je kvalita 

LLS. Především jí ovlivňují parametry leteckého skeneru, výška letu, rychlost letu, stabilita 

letu a meteorologické a klimatické podmínky. Provádění leteckého skenování                          

v mimovegetační období je důležitým předpokladem, aby k zemskému povrchu pronikaly 

vegetací paprsky v maximální míře. Také záleží na přesnosti určení prostorových souřadnic 

skeneru, přesnosti určení úhlových prvků vnější orientace skeneru a na přesnosti určení délky 

prostorového rajonu (vektoru), [6], [7]. 

Princip LLS (viz. obr. 2.1) spočívá v umístění leteckého laserového skeneru na palubu 

speciálně vybaveného letadla, odkud skener vysílá laserové paprsky v podobě krátkých pulsů 

směrem k zemskému povrchu v rovině kolmé ke směru letu. Vyslaný paprsek je vychylován 

o úhel θi od svislice a jeho délka di je určována na základě měření času mezi vysílaným         

a odraženým laserovým paprskem od terénu nebo objektů na něm (např. staveb, vegetace). 

Pomocí aparatury GNSS na palubě letadla je definována prostorová poloha skeneru                

v okamžiku vysílání pulzu v souřadnicovém referenčním systému WGS 84. U skeneru je 

připevněna aparatura IMU (inerciální měřická jednotka), která určuje prostorové rotace vůči 

letové dráze ve stejný okamžik jako aparatura GNSS souřadnice. Odraz laserového paprsku 

může být jednoduchý nebo i vícenásobný, protože část jeho energie proniká a odráží se od 

vegetačního porostu, část je odražena od vegetačního pokryvu (např. lesa) a další část proniká 

až k povrchu půdy v souvislých lesních porostech [7]. 
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Obrázek 2.1. Princip LLS - převzato z [7] 

V závislosti na vertikální členitosti území je ČR skenována po blocích o rozměrech 10 x 30 
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km. Základní parametry letů jsou uvedeny v tab. 2.2 a na obr. 2.2 [6]. 

Tabulka 2.2. Parametry LLS - převzato z [6] 

 

Parametr   Hodnoty   

Nadmořská výška letu (letová hladina) (H) 1800 m 2100 m 2400 m 

Střední výška letu nad terénem (h) 1500 m 1500 m 1250 m 

Min. nadmořská výška skenovaného území 

(H3) 

100 m 400 m 700 m 

Střední nadmořská výška skenovaného území 

(H2) 

300 m 600 m 1150 m 

Max. nadmořská výška skenovaného území 

(H1) 

500 m 800 m 1600 m 

Vzdálenost letových drah (a) 833 m 833 m 769 m 

Překryt skenování (q) 45 - 59 % 45 - 59 % 30 - 64 % 

Max. vychýlení paprsku (θmax) 30° 30° 30° 

Min. délka paprsku v nadiru (h1) 1300 m 1300 m 800 m 

Max. délka paprsku v nadiru (h3) 1700 m 1700 m 1700 m 

Minimální radiální vzdálenost (r1) 750,5 m 750,5 m 462,0 m 

Max. radiální vzdálenost (r3) 981,5 m 981,5 m 981,5 m 

Max. délka paprsku na okraji skenování (d3) 1963,0 m 1963,0 m 1963,0 m 

 

Obrázek 2.2. Parametry LLS - převzato z [6] 

Na celém území ČR je zaměřeno přibližně 800 komparačních základen pro zvýšení 

důvěryhodnosti a hlavně přesnosti DMR 5G. Základnu tvoří zpravidla horizontální bodové 
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mikropole o rozměrech 100 x 100 m. Dále obsahuje zaměřenou síť výškových bodů v mříži 

obvykle 10 x 10 m a zaměřené významné vodorovné hrany vybraných objektů, např. budov, 

bazénů. Technologie diferenciální GPS (DGPS) a elektronické tachymetry jsou využívány 

pro zaměření těchto bodů. Každý výše uvedený blok obsahuje 2 komparační základny, na 

nichž je převážně metodou GPS-RTK zaměřeno 30 kontrolních bodů. Tyto body mají střední 

souřadnicovou a výškovou chybu do 0,06 m [5], [6]. 

K záznamu dat LLS byl použit pronajatý systém Litemapper, který se skládá z leteckého 

laserového skeneru RIEGL LMS Q-680, palubní aparatury GPS Nova Tel, záznamového 

zařízení a inerciální měřické jednotky (IMU) firmy IGI. Jejich technické parametry jsou 

uvedeny v tab. 4 v literatuře [5]. 

Pokud se podíváme do pokynů pro vertikální přesnost vykazovaných dat z laserového 

skenování Americké společnosti pro fotogrammetrii a dálkový výzkum (ASPRS Guidelines), 

dělí zde nejběžnější krajinný pokryv následovně: 

 volný terén (písek, kámen, zoraná pole, trávníky, golfová hřiště); 

 vysoká tráva a plodiny; 

 křoviny a nízké stromy; 

 zalesněné plochy plně pokryté stromy; 

 městské oblasti s hustou umělou strukturou. 

V závislosti na tom upozorňuje na důležitost určení vertikální přesnosti očekávané pro 

všechny konečné produkty, které jsou dodávány. Zmiňuje se zde obecně přijímaná myšlenka, 

že testování vertikální přesnosti ve velmi nepravidelném a prudce svažitém terénu je 

nevhodné vzhledem k vysoké pravděpodobnosti, že se chyba při testování významnou měrou 

podílí na konečné statistické chybě a tak ovlivňuje výsledky. Tedy, přijatelný horizontální 

posun v datech se může projevit v nepřijatelné vertikální chybě měření. Řešením je 

rozmístění kontrolních bodů v přehledném a rozumně nízkém sklonu terénu [11]. 

2.3 Výškové systémy České republiky 

Poloha bodu či místa se může uvádět v zeměpisných souřadnicích (φ, λ) nebo v rovinných 

souřadnicích (X, Y). Zeměpisné souřadnice jsou vztaženy k náhradnímu zemskému tělesu      

a z nich jsou odvozeny rovinné souřadnice udávající polohu bodu na náhradních 
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geometrických plochách rozvinutelných do roviny. Povrch Země je však zvrásněný, proto      

k jednoznačnému určení polohy bodu na Zemi je potřeba třetí souřadnice tzv. nadmořské 

výšky [4], [8]. 

Je dobré si uvědomit, že rovinné souřadnice a nadmořská výška netvoří jeden pravoúhlý 

rovnoběžkový prostorový souřadnicový systém. Jde o dva zcela nezávislé a rozdílné 

souřadnicové systémy. Nadmořská výška podle [9] se dá definovat jako „vzdálenost bodu od 

střední hladiny moře měřená podél svislice“ [4], [9]. 

Od roku 1957 do současné doby je jediným platným výškovým systémem Balt po vyrovnání 

(Bpv). Tento systém používá Normální (Moloděnského) výšky, tzn. respektuje skutečné 

tíhové pole Země. Za nulovou hladinovou plochu je zvolen kvazigeoid [4], [8]. 

Kvazigeoid je referenční plocha charakterizovaná jako množina bodů vzdálených od 

zemského povrchu o tzv. normální výšku (zjišťuje se podle siločar tíhového pole Země). 

Rozdíl mezi geoidem a kvazigeoidem dosahuje pouze několika centimetrů. V oblasti oceánů 

jsou zmíněné plochy totožné, ale v horských oblastech se rozdíl může pohybovat i kolem 

dvou metrů [4], [8]. 

Výšky v systému Bpv jsou vztaženy ke střední hladině Baltského moře s nulovým výškovým 

bodem v Kronštadtu. Výškové bodové pole je tvořeno Českou státní nivelační sítí (ČSNS), 

která vznikla z bývalé Československé jednotné nivelační sítě (ČSJNS), [4], [8]. 

Normální výška bodu A (HAn) je délka měřená po tížnici mezi kvazigeoidem a bodem na 

povrchu Země, viz. obr. 2.3. Dále je níže zakreslena normální ortometrická výška HAγ                    

a pravá ortometrická (geodetická) výška HAg [8]. 

 

Obrázek 2.3. Výšky bodu nad referenčními plochami - převzato z [8] 
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2.3.1 Historie výškových systémů na území České republiky 

Naše země byly v 19. století stále součástí Rakouska-Uherska. Historické počátky budování 

výškového bodového pole sahají právě do této doby, odkud pochází soubor měření 

Vojenského zeměpisného ústavu ve Vídni, orientace na střední hladinu Jaderského moře 

(Terst) i základní nivelační bod Lišov [4], [8]. 

Na základě rozsáhlého měření v rámci Rakouska-Uherska v letech 1872-1896 došlo poprvé   

k přesnému určení nadmořské výšky na území našeho státu. Z dlouhodobého pozorování byla 

v přístavu Terst určena střední (nulová) hladina Jaderského moře. Od tohoto nulového bodu 

pak postupovalo měření (geometrická nivelace) do vnitrozemí. Probíhalo po trasách mírného 

spádu, tedy většinou po železničních tratích a silnicích. Při měření se začalo s budováním tzv. 

základních nivelačních bodů (ZNB). Na území bývalého Československa byly zřízeny dva 

body (ZNB), jeden v jižních Čechách u města Lišov a druhý na Slovensku u Strečna. 

Základní nivelační body svojí hustotou nestačily, proto se jejich síť začala zhušťovat. Na 

území bývalého Československa tak vznikla po roce 1945 souvislá nivelační síť I. až           

III. řádu [4], [8]. 

Brzy po 2. světové válce byla snaha ve společenství tzv. socialistických zemí z vojenských    

a politických důvodů sjednotit geodetické systémy. Změny nastaly v naší výškové nivelační 

síti, zatímco polohový souřadnicový systém JTSK používaný pro civilní mapy velkých 

měřítek nebyl podstatně ovlivněn. Nadmořské výšky určené v jaderském systému bylo nutno 

převést na nový systém [4], [8]. 

V současné době, jak zmiňuji výše, je zaveden a používán výškový systém Balt po 

vyrovnání. Rozdíl mezi jaderským a baltským systémem činí po vyrovnání přibližně -0,40 m. 

Rozdíl -0,40 m však není konstantní. Mění se při tíhových anomáliích (vysoké hory), větších 

převýšeních a je ovlivňován také různým způsobem vyrovnání. Proto je nutno vždy uvádět 

výškový systém u každého bodu [4]. 

Přehled výškových systémů používaných na našem území je znázorněn v tab. 2.3. 
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Tabulka 2.3. Přehled výškových systémů použitých na území ČR - převzato z [8] 

 

Výškový 

systém 

Časové 

období 

Výškové 

bodové 

pole (síť) 

Střední hladina 

moře 

Druh 

použitých 

výšek 

Způsob 

vyrovnání 

sítě 

Výška 

výchozíh

o bodu 

pro ČR - 

Lišov 

[m] 

Jaderský 

- Lišov 

1875 - 1942 Doplněná 

nivelační 

síť 

Rakouska-

Uherska z 

let 1872 - 

1896 

Jaderského s 

nulovým bodem 

v Terstu 

Normální 

ortometrické 

Území Čech 

a Moravy 

565,1483 

Normal - 

Null 

(NN) 

1945 - 1948 Nivelace I. 

řádu 

zaměřená 

v letech 

1939 - 

1941 

Severního s 

nulovým bodem 

v Amsterodamu 

Normální 

ortometrické 

V rámci V. 

bloku 

německé sítě 

564,8997 

Jaderský 

- ČSJNS 

(ČSJNS/

J) 

1948 - 1999 ČSJNS Jaderského s 

nulovým bodem 

v Terstu 

Normální 

ortometrické 

Roku 1948 

byla 

vyrovnána 

českomorav- 

ská část sítě, 

roku 1952 

celá ČSSR 

565,1483 

Baltský - 

B68 

1952 - 1957 

(dočasné) 

ČSJNS Baltského s 

nulovým bodem 

v Kronštadtu 

Normální 

ortometrické 

Výšky byly 

vypočteny 

odečtením 

hodnoty 0,68 

m od výšek 

jaderských 

564,4683 

Baltský - 

B46 

1955 - 1957 

(dočasné) 

ČSJNS Baltského s 

nulovým bodem 

v Kronštadtu 

Normální 

ortometrické 

Výšky byly 

vypočteny 

odečtením 

hodnoty 0,46 

m od výšek 

jaderských 

564,6883 

Baltský - 

po 

vyrovná- 

ní (Bpv) 

1957 - 

současnost 

ČSJNS Baltského s 

nulovým bodem 

v Kronštadtu 

Normální 

(Moloděnské- 

ho) 

Mezinárodní 

v rámci 

socialistic- 

kých států 

roku 1957 

564,7597 

2.3.2 Výškové bodové pole a parametry přesnosti 

V současnosti se výškové bodové pole ČR člení na základní výškové bodové pole (ZVBP)     
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a podrobné výškové bodové pole (PVBP). ZVBP obsahuje základní nivelační body (ZNB)    

a body české nivelační sítě I. až III. řádu (ČSNS). PVBP obsahuje nivelační sítě IV. řádu, 

plošné nivelační sítě (PNS) a stabilizované body technických nivelací [4]. 

Po celém území ČR je rozmístěno 11 ZNB, z nichž mezi nejznámější patří Lišov [4]. 

Nivelační pořady seskupené do nivelačních polygonů tvoří ČSNS I. řádu. Nivelační polygony 

mají délku 300 až 400 km, vytvářejí uzavřené obrazce a ohraničují tzv. nivelační oblasti         

I. řádu. Oblasti se označují od západu k východu a po vrstvách od severu k jihu velkými 

písmeny (A, B, C, ...). V pohraničí se označují Z1 až Z17 od Ašského výběžku směrem na 

sever. Např. NO Jihlava - Jemenice je označení nivelačního pořadu, přičemž dvojice velkých 

písmen představuje styčné oblasti a názvy míst začátku a konce pořadu [4]. 

Vložením nivelačních pořadů II. řádu do polygonů I. řádu vzniká ČSNS II. řádu. Pořady      

II. řádu s částmi pořadů I. řádu společně tvoří uzavřené polygony o délce kolem 100 km        

a zároveň ohraničují oblasti II. řádu. Tyto oblasti se označují dvěma písmeny, např. Na, Nb, 

tedy velkým písmenem oblasti I. řádu a malým písmenem (a, b, c, ...). Malá písmena se 

přidělují opět od západu k východu a po vrstvách od severu k jihu. Např. Nab Pelhřimov - 

Jindřichův Hradec označuje nivelační pořad, kde velké písmeno patří oblasti I. řádu, dvě malá 

písmena styčným oblastem II. řádu a názvy míst počátku a konci pořadu [4]. 

Síť I. a II. řádu se dále zhušťuje pořady III. řádu a tvoří se tak ČSNS III. řádu. Nivelační 

pořady III. řádu se označují velkým písmenem oblasti I. řádu, malým písmenem II. řádu, 

pořadovým číslem a názvem míst počátku a konce pořadu, např. Na4 Mlýny Soběslav [4]. 

Nivelační pořady IV. řádu tvoří nivelační síť IV. řádu. Označují se velkým písmenem oblasti 

I. řádu, malým písmenem oblasti II. řádu, 0 s pořadovým číslem a názvy míst začátku a konce 

pořadu, např. Na 01 Sezimovo Ústí - Chýnov [4]. 

Podle potřeby se budují plošné nivelační sítě (PNS) zpravidla pro území obce. Pořady se 

označují pořadovým číslem a názvem obce, např. 34 (PNS Praha), [4]. 

Pro dostatečnou názornost je označování nivelačních pořadů zobrazeno na obr. 2.4. 
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Obrázek 2.4. Označování nivelačních pořadů - převzato z [4] 

Označování nivelačních bodů nalezneme v [10]: „Nivelační body se označují v evidenčních 

jednotkách, kterými jsou nivelační pořad nebo plošná nivelační síť. Nivelační sítě, pořady       

a body jsou zobrazeny v dokumentačních mapách a v přehledech“. 

„Přesnost výšek nivelačních bodů je určena podle střední chyby mL nivelačního převýšení 

mezi nivelačními body, která nepřekračuje hodnotu mL = m * √L (v mm), kde „m“ je 

základní střední kilometrová chyba nivelačního převýšení a L vzdálenost nivelačních bodů                  

v kilometrech. Mezní velikost základní střední kilometrové chyby nivelačního převýšení „m“ 

je stanovena hodnotou (v mm):  

 0,40 + 0,71 / √nR pro I. řád; 

 0,45 + 0,80 / √nR pro II. řád; 

 0,60 + 1,06 / √nR pro III. řád; 

 1,00 + 1,77 / √nR pro IV. řád a plošné nivelační sítě, kde nR je počet nivelačních oddílů 

v posuzovaném převýšení“ [10]. 

Podle [4] má např. síť I. řádu ČSNS přesnost charakterizovanou střední kilometrovou chybou 

mL = 0,88 mm. 
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3. Příprava dat 

Následující kapitola blíže popisuje používaná data v této práci. Jde o data ZABAGED, data 

LLS a nivelační body. Celý produkt vznikal v níže zobrazených lokalitách s využitím dat, 

která poskytl Zeměměřický úřad. Produkt vznikal v programu ArcGIS verze 9.3, v programu 

Kokeš verze 9.67.0.31092, v programu Atlas DMT verze 4.70.4 a v programu Microsoft 

Office Excel 2007. Licence pro chod prvních tří programů byla poskytnuta katedrou 

matematiky ZČU v Plzni. 

Pro hodnocení přesnosti jsou vybrány tři dvojice lokalit, přičemž každou dvojici 

charakterizuje odlišný typ zástavby: rodinné domy (viz. obr. 3.2 a obr. 3.3), bytové domy 

(viz. obr. 3.4 a obr. 3.5) nebo panelové domy (viz. obr. 3.6 a obr. 3.7). Mají jiný tvar, ale 

přibližně stejnou rozlohu. Obvod každé lokality je nakreslen v programu ArcGIS do jednoho 

shapefile typu polygon. Následně je připojena WMS služba přes server v ArcMapu                  

a jsou vytvořeny náhledy. Prostorové rozmístění vybraných lokalit je na obr. 3.1. 

 

Obr. 3.1 Přehledka vybraných lokalit 
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Obrázek 3.2. Rodinné domy Na Hvězdě           Obrázek 3.3. Rodinné domy na Lochotíně 

                                                                                            

Obrázek 3.4. Bytové domy v centru Plzně         Obrázek 3.5. Bytové domy na Slovanech 

                             

Obrázek 3.6. Panelové domy na Vinicích           Obrázek 3.7. Panelové domy na Košutce 

3.1 ZABAGED 

Data ZABAGED se v současné době poskytují po mapových listech v kladu ZM 10 nebo 

jako ucelená bezešvá databáze z celého území České republiky. Vektorové soubory se 
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poskytují ve formátu *.dgn s atributy ve formátu *.mdb, dále ve formátu *.shp nebo *.gml. 

ZABAGED - výškopis byl pro účely této práce poskytnut po mapových listech ZM 10       

(12-33-11, 12-33-16, 12-33-21 a 12-33-22) v souborech ve formátu *.dgn. Pro vlastní tvorbu 

DMT je třeba nejprve data oříznout podle zvolených lokalit a pak převést do formátu *.dxf, 

který podporuje program Atlas DMT. Každý mapový list a obvod lokality je načten do 

programu Kokeš v hlavním menu Soubor → Import → Import DGN nebo Soubor → Import 

→ Import SHP. Vše je uloženo s příponou *.vyk. Ořezávání mapových listů pobíhá ručně 

přes hlavní menu Help → Seznam povelů → Ořezávání výkresu na obdélník nebo polygon, 

přičemž je vždy otevřen obvod lokality a příslušný mapový list. Když lokalita zasahuje do 

dvou mapových listů, provede se ořez pro každý mapový list zvlášť a data se spojí až při 

exportu do formátu *.dxf. 

 

Obrázek 3.8. Ukázka oříznuté ZABAGED - výškopis na Slovanech 

ZABAGED - zdokonalený výškopis byl pro účely této práce poskytnut ve vektorové podobě 

ve formátu *.shp. Z této bezešvé databáze používám jen tři vrstvy (vrstevnice hlavní, 

vrstevnice zesílená a vrstevnice doplňková), protože jiné objekty se ve mnou vybraných 

lokalitách nevyskytují. Postup zpracování se shoduje s výše uvedeným postupem, jemuž 

předcházely následující operace v programu ArcGIS. V ArcToolboxu je oříznut vždy 

přislušný shapefile pomocí funkce „Clip (analysis)“ větším okolím než je vybraná lokalita, 

aby do programu Kokeš nebylo importováno velké množství dat. K případnému zmenšení dat 

(zkrácení čí umazání vrstevnic) dochází až v programu Kokeš a výstupy jsou podobné jako 

na obr. 3.8. 
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3.2 LLS 

V práci jsou použita data leteckého laserového skenování zpracovaná automatickou 

klasifikací uložena v souborech po skenovacích pásech ve formátu *.xyz. Pracuje se pouze 

s body, které byly automatickou klasifikací zařazeny do kategorie „ground“, tzn. mělo by jít    

o body, které leží na zemském povrchu. Jak je vidět na obr. 3.9, body LLS nejsou číslovány. 

Každý bod má informaci pouze o své poloze (Y, X, H). Polohové souřadnice mají záporné 

hodnoty souřadnicového systému JTSK a výška je uvedena ve výškovém systému Balt po 

vyrovnání. Záporné znaménko je proto, aby program, který pracuje s kartézským 

souřadnicovým systémem, načetl správnou polohu dat. Tato data je třeba nejprve připravit ke 

dvojímu zpracování:  

 pro generaci DMT v podobě TIN; 

 pro porovnání s výškami nivelačních bodů. 

 

Obrázek 3.9. Ukázka dat LLS 

Nejprve je třeba načíst data LLS do programu ArcGIS. Lze to provést v ArcToolboxu, kde se 



   

 21  

otevře 3D Analyst Tools → Conversion → From File → ASCII 3D to Feature Class a načtou 

se data po skenovacích pásech s typem shapefile multipoint. 

Pro tvorbu DMT v podobě TIN následuje ořez dat pomocí funkce „Clip (analysis)“, kterou 

lze spustit opět z ArcToolboxu vždy pro každou lokalitu zvlášť. Načtená data jsou ořezávána 

předem připravenými shapefiles typu polygony, které obsahující obvody lokalit (viz. výše). 

Když lokalita zasahuje do dvou skenovacích pásů LLS, provede se ořez lokality pro každý 

pás zvlášť a následně se spojí v ArcToolboxu funkcí „Merge (management)“. Grafické 

znázornění ořezaných dat LLS pro tvorbu DMT v lokalitě Slovany je na obr. 3.10. 

Pro vlastní tvorbu modelu terénu ve formě TIN je třeba tato data vyexportovat do souboru 

*.txt pro následné zpracování v programu Atlas DMT. Lze to provést v ArcToolboxu pomocí 

3D Analyst Tools → Conversion → From Feature Class → Feature Class Z to ASCII. 

Protože v programu Atlas DMT mají souřadnicové osy směr jako S-JTSK, je třeba minusové 

souřadnice (Y, X) opravit na kladné. 

 

Obrázek 3.10. Grafické znázornění dat LLS pro tvorbu DMT na Slovanech 

Pro výškové porovnání s nivelačními body je třeba všechna data v pásech oříznout znovu. 

Okolo každého nivelačního bodu je nejprve v ArcToolboxu vytvořen kruh o poloměru 5 m 

pomocí funkce „Buffer (analysis)“. Každý naskenovaný pás dat je v ArcToolboxu touto 

vrstvou oříznut pomocí funkce „Clip (analysis)“ a následně spojen do jednoho shapefile 

pomocí funkce „Merge (management)“. Na obr. 3.11 je ukázka rozložení bodů LLS (světle 

modré) okolo jednoho nivelačního bodu (žlutý). Zelená plocha znázorňuje pětimetrové okolí 
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nivelačního bodu. 

Body LLS spadající do kruhového okolí nivelačních bodů o poloměru 5 m mají stále typ 

shapefile multipoint. Ten je však výhodný jen pro načítání a zobrazování velkého množství 

bodů. Proto se použije funkce „Multipart To Singlepart (management)“, která vrstvu 

„svázaných bodů“ převede na bodovou vrstvu. Avšak po tomto kroku nejsou stále viditelné 

souřadnice (X, Y, Z), proto se použije funkce „Add XY Coordinates (management)“.  

 

Obrázek 3.11. Grafické znázornění dat pro výškové porovnání nivelačních bodů a LLS 

3.3 Nivelační body 

Zeměměřický úřad vede databázové soubory bodů bodového pole a eviduje je v technických 

jednotkách (podle zákona 359/92 Sb.). Databáze bodových polí obsahuje trigonometrické       

a zhušťovací body, přidružené body, nivelační body ČSNS a ČPNS, tíhové body. Tato práce 

však používá pouze nivelační body následujících katastrálních území (k.ú.):  

 Bolevec, 

 Božkov, 

 Bručná, 

 Bukovec, 

 Černice, 

 Červený Hrádek u Plzně, 
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 Dolní Vlkýš, 

 Doubravka, 

 Hradiště u Plzně, 

 Koterov, 

 Křimice, 

 Lhota u Dobřan, 

 Litice u Plzně, 

 Lobzy, 

 Malesice, 

 Plzeň, 

 Plzeň 4, 

 Radčice u Plzně, 

 Radobyčice, 

 Svrňany, 

 Újezd, 

 Valcha. 
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Obrázek 3.12. Prostorové uspořádání katastrálních území města Plzně - tisk [18] 

Jde o k.ú. náležející jak do okresu Plzeň-město, tak do města Plzeň (viz. obr. 3.12). Zde 

tmavě modrá silná čára představuje obvod města Plzně. Zvýrazněná katastrální území, mimo 

obvod města Plzně, spadají pouze do okresu Plzeň-město. 

Protože Zeměměřický úřad uchovává informace o nivelačních bodech jen v podobě 

nivelačních údajů, je nutno polohové souřadnice a výšku opsat pro každý bod do předem 

připravené atributové tabulky v programu ArcGIS. Nejprve je pro každé katastrální území 
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vytvořena nová bodová vrstva v ArcCatalogu s příšlušným názvem katastrálního území.       

V ArcMapu následuje její otevření a vytvoření sloupců s názvy „Cislo_bodu“, „Y1“, „X1“, 

„Z“, „Z_nad_ter“, „Popis“, „k_u“. Následně je tabulka vyplněna a zkopírována do Microsoft 

Office Excel 2007. Zde se dopočítají sloupce „Y2“, „X2“ a „Z_na_ter“. Po výpočtech je 

tabulka načtena zpět do ArcMapu přes hlavní menu Tools → Add XY data. 

Sloupec „Cislo_bodu“ obsahuje názvy nivelačních bodů. Sloupce „Y1“ a „X1“ obsahují 

polohové souřadnice v S-JTSK a sloupce „Y2“ a „X2“ jejich záporné hodnoty. Sloupec      

„Z“ obsahuje výšky nivelačních bodů a sloupec „Z_nad_ter“ umístění nivelačních značek nad 

terénem. Protože porovnáváme výšky terénu, je potřeba vždy znát „výšky nivelačních bodů“ 

na terénu. Ty jsou ve sloupci s názvem „Z_na_ter“. Sloupce „Popis“ a „k_u“ mají 

informativní charakter. Ukázka dat pro k.ú. Bolevec je na obr. 3.13. 

 

Obrázek 3.13. Ukázka dat pro k.ú. Bolevec 

Po snadnější zpracování dat jsou všechny soubory nivelačních bodů ve formátu *.shp 

sloučeny do jednoho s názvem „nivelacni_body.shp“. Takto zpracovaná data jsou připravena 

k využití pro porovnání a výpočty popsány v kapitole 4. 

Co se týká dělení bodů podle k.ú., tak body z k.ú. Bručná na internetových stránkách [15] 

chyběly. Pracovník katastrálního pracoviště Plzeň-město Petr Šlajs mi poskytl informaci        

o tom, že nivelační body jsou v k.ú. Černice, protože k.ú. Bručná byla oddělena až později. 

Taktéž mi poskytl správné nivelační údaje bodu č. PL-000-815 z k.ú. Bolevec, protože na 

internetu se vyskytl přepis v řádech stovek metrů a bodu Af01-83 z k.ú. Křimice, který se na 

internetových stránkách [15] nezobrazoval. Bod Af01-83 má své správné nivelační údaje 

uloženy v samostatném souboru. 
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Nivelační body jsou vybrány v závislosti na stabilizaci a nivelačních údajích. Ke zpracování 

se tedy dostávají takové body, které leží přímo na terénu, nebo je možné výšku terénu od nich 

dopočítat. Vhodnými body jsou např. nivelační body osazeny čepovými značkami                       

v budovách. V použitých nivelačních bodech nejsou zahrnuty např. nivelační kameny, 

silniční propustky a značky, které jsou osazeny shora v betonových základech stožárů             

a nemají v nivelačních údajích uvedeny výšku betonového základu. 

Všechny nivelační údaje bodů jsou rozděleny podle názvů katastrálních území na přiloženém 

DVD. Body, které nejsou použity, mají v příloze za svým číslem velké písmeno „N“. 
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4. Vytvoření trojúhelníkových sítí a porovnání výškových rozdílů 

Pro hodnocení výškové přesnosti je vybrána metoda DMT, která dokáže zachytit terénní 

hrany a umožňuje hodnotit celou vybranou plochu a ne jen vybrané body. Před vlastním 

porovnáním dvou různě přesných modelů terénu se musí vytvořit jejich nepravidelné 

trojúhelníkové sítě. Modely terénu ve formě TIN reprezentují zemský povrch jako skupinu 

trojúhelníků rozdílné velikosti a tvaru. Zde je každému vrcholu trojúhelníka přiřazena vždy 

jedna nadmořská výška. Pomocí TIN tedy nelze zobrazit svislé plochy a převisy terénu. 

Tvorba digitálních modelů terénů ve formě TIN a jejich rozdílové modely jsou tvořeny pouze 

v programu Atlas DMT a následně vyexportovány do souborů ve formátu *.bmp. Zpracování 

nivelačních bodů a dat LLS je provedeno v programu ArcGIS. 

4.1 Tvorba TIN nad ZABAGED 

V programu Atlas DMT je použita funkce „Generace modelu terénu“, který lze spustit            

z hlavního menu DMT → Úlohy nad DMT → Operace s modelem → Generace modelu 

terénu. Zde se do okna „Model terénu“ nastaví adresářové umístění a jméno vytvářeného 

modelu terénu, do okna „Vstupní data bodů“ se zvolí vstupní soubor výškopisných dat ve 

formátu *.dxf (viz. obr. 4.1). 

 

Obrázek 4.1. Nastavení tvorby DMT 

Položka „Vlastnosti“ (viz. obr. 4.2) umožňuje pokročilá nastavení pro řízení tvorby modelu. 
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Pro tuto diplomovou práci je důležité jen nastavení týkající se možnosti tvorby modelu. 

Průběh tvorby se zapisuje do protokolu (tj. do souboru s příponou *.prt). Zvýrazněné pole 

„Připojit data k existujícímu modelu“ nebylo potřeba, protože vstupními daty jsou ve 

vybraných lokalitách vždy pouze vrstevnice. 

 

Obrázek 4.2. Vlastnosti tvorby modelu terénu 

Posledním krokem je volba vrstev pro tvorbu a způsob, jakým mají být zpracovány (viz.     

obr. 4.3). Zde se pomocí žárovek určuje, které vrstvy budou zahrnuty do tvorby modelu. 

Zhasnutím žárovky se daná vrstva (hladina) z tvorby vyloučí. Spojnice definuje typ hrany, 

jestliže daná vrstva hrany obsahuje. Písmeno „P“ označuje povinné hrany, kde nedochází        

k lomu vrstevnic, např. vrstevnice, hřbetnice. Písmeno „L“ označuje lomové hrany, tedy kde 

dochází k lomu vrstevnic, např. hrany svahů, násypů. Písmeno „R“ označuje přímé hrany 

(hrany skutečně přímé v prostoru), např. budovy, betonové desky. Písmeno „O“ označuje 

ostrovní lomové hrany, které vymezují oblast, v níž se výškopis nevyhodnocuje. Tyto hrany 

jsou prostorově zakřiveny. Písmeno „U“ označuje ostrovní přímé hrany stejně jako lomové, 

ale tyto hrany jsou skutečně přímé v prostoru. Start spouští tvorbu modelu, po jejímž 

ukončení se její průběh zobrazí v protokolu. V diplomové práci je všem vrstvám přiřazeno 

písmeno „P“. 
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Obrázek 4.3. Výběr vrstev a typu spojnic 

Všechna grafická znázornění DMT mají stejnou hypsometrii, ale rozdílné intervaly, které 

jsou nastaveny podle výškového rozložení lokality. 

4.2 Tvorba TIN nad daty leteckého laserového skenování 

Tvorba TIN nad daty LLS má stejný postup jako je uveden výše. Co doznává změn, je formát 

vstupních dat (*.txt) a jeho nastavení. Stisknutím tlačítka „Fmt“ se otevře nastavení formátu 

souboru (viz. obr. 4.4), kde je třeba nastavit formát, oddělovač textového kódu (mezera)            

a souřadnicovou soustavu. 

 

Obrázek 4.4. Nastavení formátu souboru 

Mezi změny se dá zařadit i fakt, že není třeba vybírat vrstvy a typy spojnic před tvorbou 

DMT. Start spouští tvorbu modelu, po jejímž ukončení se její průběh zobrazí opět                        
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v protokolu. 

Všechna grafická znázornění DMT mají stejnou hypsometrii jako v předchozí kapitole, ale 

rozdílné intervaly, které jsou nastaveny podle výškového rozložení lokality. 

4.3 Výškové rozdíly a výpočet chyb LLS a ZABAGED 

Jde o výpočet prolínání dvou vstupních trojúhelníkových sítí a tvorbu výsledného 

rozdílového modelu. Pro tuto úlohu je použita funkce „Prolínání sítě“, kterou lze spustit            

z hlavního menu DMT → Úlohy nad DMT → Výpočty → Prolínání dvou sítí (viz. obr. 4.5). 

 

Obrázek 4.5. Nastavení výpočtu výškových rozdílů 

V okně „Model 1“ a „Model 2“ se nastaví vždy adresářové umístění a jméno porovnávaného 

modelu terénu. V okně „Výsledný model“ se otevře nový model terénu, kde bude uložen 

výsledný rozdílový model. Výsledný model je nastaven na rozdílový model. Tímto postupem 

jsou vypočteny výškové rozdíly pro všechny vybrané zkušební lokality z dat LLS, ze 

ZABAGED - výškopis a ze ZABAGED - zdokonalený výškopis. Grafické znázornění 

výškových rozdílů je zobrazeno na následujícím obr. 4.6. 

 

Obrázek 4.6. Barevná hypsometrie pro rozdílové modely 
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K výpočtu chyb pro každý rozdílový model je použita funkce „Výpočet objemu“, kterou lze 

spustit z hlavního menu DMT → Úlohy nad DMT → Výpočty → Výpočet objemu. Výpočet 

se provádí pro celý rozdílový model vzhledem ke srovnávací rovině o výškové kótě 0 m. 

Objem je počítán jako součet objemů trojbokých hranolů nad jednotlivými trojúhelníky 

rozdílového modelu. Všechny kladné hodnoty jsou sečteny do kladné části objemu, stejně tak 

všechny záporné hodnoty jsou sečteny do záporné části objemu. Výsledné hodnoty jsou 

vyjádřeny číselnými hodnotami a uloženy do textového souboru. Mezi číselné hodnoty 

získané funkcí „Výpočet modelu“ patří: 

VÝSLEDNÝ OBJEM : 

V[+] ... kladná část objemu v metrech kubických 

V[-] ... záporná část objemu v metrech kubických 

V[+] + V[-] ... součet objemů v metrech kubických 

abs(V[+]) + abs(V[-]) ... součet absolutních hodnot objemů v metrech kubických 

CELKOVÁ PLOCHA : 

A[+] ... plocha rozdílového modelu odpovídající objemu V[+] v metrech čtverečních 

A[-] ... plocha rozdílového modelu odpovídající objemu V[-] v metrech čtverečních 

A[0] ... plocha, kde jsou porovnávané modely totožné v metrech čtverečních 

A ... celková plocha rozdílového modelu v metrech čtverečních 

POVRCH MODELU : 

Hlavní model S[celk] ... (pro výpočty není potřebný) 

Srovnávací model S[celk] ... (pro výpočty není potřebný) 

Výše uvedené hodnoty slouží k určení parametrů přesnosti charakteristické pro vybrané 

lokality:   

 průměrná chyba    = {V[+] + |V[-]|}/A v metrech; 

 systematická chyba    = {V[+] - |V[-]|}/A v metrech; 
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 odhad základní úplné střední chyby charakterizující reálnou přesnost    = 1,25 *       

v metrech; 

 odhad základní střední náhodné chyby    = √(  
2
 -   

2
) v metrech. 

Tabulka uvedených parametrů přesnosti v jednotlivých lokalitách je uvedena v kapitole 4.4 

na obr. 4.9. 

4.4 Výsledky vyhodnocení ve zkušebních lokalitách 

Výsledky ovlivňují chyby v automatické klasifikaci dat LLS. Letecké laserové skenování má 

problém s vyhodnocením dat v komplexech budov, např. centrum Plzně. Obrázek 4.7 ukazuje 

DMT vytvořený z automaticky klasifikovaných bodů LLS. Na obr. 4.8 je pak DMT 

s odstraněnými chybně klasifikovanými body, který vystihuje skutečný průběh terénu a má 

manuálně odstraněny chyby v řádech metrů (max. 9 m). Lépe na tom je lokalita Košutka, kde 

jde o špatně vyhodnocenou střechu. Další chyby, co se týká odrazu laserového paprsku, jsou 

jen lokální a malého rozsahu. Vyskytují se v lokalitě rodinných domů na Lochotíně, kde 

dochází ke špatnému odrazu laserového paprsku od bazénů na zahradách. Chyby dosahují 

řádově několika metrů (max. 10 m) a jsou také odstraněny ze vstupních dat DMT. 

                 

Obrázek 4.7. DMT z neopravených dat LLS    Obrázek 4.8. DMT z opravených dat LLS 

(přibližné měřítko 1: 700)                                    (přibližné měřítko 1: 700) 

Pro vzájemné porovnání jsou na následujícím obr. 4.9 (tabulce) znázorněny výsledky 

průměrné hodnoty   , systematické chyby   , odhad základní úplné střední chyby              

a odhad základní střední náhodné chyby    se vstupními hodnotami (A[+], A[-], A[0], A, 

V[+] a V[-]). Na první pohled je patrné, že    a    rozdílových modelů zdokonaleného 

výškopisu ZABAGED a dat LLS dosahují nižších hodnot, než u rozdílových modelů 

ZABAGED a dat LLS, což bylo cílem zdokonalení databáze ZABAGED. Podle předpokladů 
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jsou největší výškové rozdíly v lokalitách panelových domů. 

 

Obrázek 4.9. Výsledky vyhodnocení ve zkušebních lokalitách 

Na následujících obrázcích (obr. 4.10 až obr. 4.33) jsou znázorněny rozdílové modely             

k jednotlivým lokalitám. Pro lepší reprezentaci mají u sebe vždy obrázek s obvodem lokality 

a ortofotem. V následujících odstavcích budou komentovány rozdílové modely jednotlivých 

lokalit, přičemž každé dvě lokality charakterizuje odlišný typ zástavby: rodinné domy, bytové 

domy nebo panelové domy.  

4.4.1 Lokality s bytovou zástavbou 

Porovnávanou skupinou rozdílových modelů jsou lokality s bytovou zástavbou (lokalita              

v centru Plzně a lokalita na Slovanech). Po odstranění chybně klasifikovaných bodů z dat 

LLS v centru Plzně vyšly rozdílové modely ZABAGED s daty LLS velmi podobně (viz.    

obr. 4.10 a obr. 4.11). Když se podíváme na rozdílové modely  ZABAGED s daty LLS na 
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Slovanech, jsou zde oproti centru Plzně zřejmé „díry“ po střechách bytových domů (viz. obr. 

4.14 a obr. 4.15). Na všech rozdílových modelech (viz. obr. 4.10, obr. 4.11, obr. 4.14 a obr. 

4.15 ) jsou dobře patrné silnice. Pokud se podíváme na rozdílové modely ZABAGED - 

výškopis a ZABAGED - zdokonalený výškopis (viz. obr. 4.12 a obr. 4.16), tak výškové 

rozdíly dosahují malých hodnot řádově několika desítek centimetrů. Na těchto modelech 

nelze rozpoznat žádné budovy ani silnice, protože porovnávané modely mají výškopis 

reprezentovaný pouze vrstevnicemi. Střední chyba výšky pro ZABAGED - výškopis              

i ZABAGED - zdokonalený výškopis dosahuje podle tab. 2.1 (v kapitole 2.1.2) jednoho až 

dvou metrů v intravilánech. Vybrané lokality s bytovou zástavbou splňují kritérium střední 

chyby ve výšce podle tab. 2.1. Největší chyby ve výškách se projevují v nedostupných 

komplexech budov. 

                   

Obrázek 4.10. Rozdílový model                              Obrázek 4.11. Rozdílový model  

ZABAGED - zdokonalený výškopis                       ZABAGED - výškopis a LLS 

a LLS v centru Plzně                                               v centru Plzně 

(přibližné měřítko 1: 1 700)                                    (přibližné měřítko 1: 1 300)                  

                        

Obrázek 4.12. Rozdílový model                      Obrázek 4.13. Bytové domy v centru Plzně 

ZABAGED - zdokonalený výškopis  

a ZABAGED - výškopis v centru Plzně  

(přibližné měřítko 1: 1 700) 
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Obrázek 4.14. Rozdílový model                        Obrázek 4.15. Rozdílový model 

ZABAGED - zdokonalený výškopis                 ZABAGED - výškopis a LLS  

a LLS na Slovanech                                           na Slovanech 

(přibližné měřítko 1: 1 800)                              (přibližné měřítko 1: 1 500) 

 

 
 

                                                                                    

Obrázek 4.16. Rozdílový model                        Obrázek 4.17. Bytové domy na Slovanech 

ZABAGED - zdokonalený výškopis  

a ZABAGED - výškopis na Slovanech 

(přibližné měřítko 1: 1 800)                               

4.4.2 Lokality s panelovou zástavbou 

Porovnávanou skupinou lokalit rozdílových modelů jsou lokality s panelovou zástavbou 

(lokalita na Košutce a lokalita na Vinicích). Po odstranění chybně klasifikovaných bodů z dat 

LLS na Košutce vyšly rozdílové modely ZABAGED s daty LLS jako v předchozím případě 

velmi podobně (viz. obr. 4.18 a obr. 4.19). Na všech rozdílových modelech (viz. obr. 4.18, 

obr. 4.19, obr. 4.22 a obr. 4.23 ) jsou dobře patrné silnice. Co se týká rozpoznávání budov, 

liniová panelová zástavba na Košutce a na Vinicích je dobře identifikovatelná. Částečně 
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uzavřené komplexy budov na Vinicích, které nemusí být na první pohled patrné, mají spíše 

podobu neostře uzavřené oblasti. Pokud se podíváme na rozdílové modely ZABAGED - 

výškopis a ZABAGED - zdokonalený výškopis (viz. obr. 4.20 a obr. 4.24), tak výškové 

rozdíly dosahují řádově jednoho metru. Největší zpřesnění („změny“) databáze ZABAGED 

jsou patrná v lokalitě na Vinicích (levý dolní roh rozdílového modelu - viz. obr. 4.24). Na 

těchto modelech nelze opět rozpoznat žádné budovy ani silnice, protože porovnávané modely 

mají výškopis reprezentovaný pouze vrstevnicemi. Střední chyba výšky pro ZABAGED - 

výškopis i ZABAGED - zdokonalený výškopis dosahuje podle tab. 2.1 (v kapitole 2.1.2) 

jednoho až dvou metrů v intravilánech. Vybrané lokality s panelovou zástavbou splňují 

kritérium střední chyby ve výšce podle tab. 2.1 v kapitole 2.1.2.  

 

                          

Obrázek 4.18. Rozdílový model                           Obrázek 4.19. Rozdílový model 

ZABAGED - zdokonalený výškopis                    ZABAGED - výškopis  

a LLS na Košutce                                                 a LLS na Košutce 

(přibližné měřítko 1: 1 200)                                 (přibližné měřítko 1: 1 200) 
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Obrázek 4.20. Rozdílový model                         Obrázek 4.21. Panelové domy na Košutce 

ZABAGED - zdokonalený výškopis  

a ZABAGED - výškopis na Košutce 

(přibližné měřítko 1: 1 200) 

 

 

 

                                     

 

Obrázek 4.22. Rozdílový model                       Obrázek 4.23. Rozdílový model 

ZABAGED - zdokonalený výškopis                ZABAGED - výškopis  

a LLS na Vinicích                                             a LLS na Vinicích 

(přibližné měřítko 1: 1 200)                              (přibližné měřítko 1: 1 000) 
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Obrázek 4.24. Rozdílový model                              Obrázek 4.25. Panelové domy  

ZABAGED - zdokonalený výškopis                       na Vinicích 

a ZABAGED - výškopis na Vinicích 

(přibližné měřítko 1: 1 200) 

4.4.3 Lokality s rodinnými domy 

Poslední skupinou lokalit rozdílových modelů jsou lokality s rodinnými domy (lokalita na 

Lochotíně a lokalita Na Hvězdě). Na všech rozdílových modelech (viz. obr. 4.26, obr. 4.27, 

obr. 4.30 a obr. 4.31) je patrná „roztroušená zástavba“ malých domků. Na rozdílových 

modelech ZABAGED s daty LLS jsou zřetelně vidět silnice (např. Na Hvězdě kruhový 

objezd s navazujícími silnicemi). Pokud se podíváme na rozdílové modely ZABAGED - 

výškopis a ZABAGED - zdokonalený výškopis (viz. obr. 4.28 a obr. 4.32), tak výškové 

rozdíly dosahují většinou řádově desítek centimetrů. Nejlépe jsou vyhodnocené cesty               

a silnice, což platí i o předchozích dvou skupinách lokalit. Jak již bylo napsáno výše, střední 

chyba výšky pro ZABAGED - výškopis i ZABAGED - zdokonalený výškopis dosahuje podle 

tab. 2.1 (v kapitole 2.1.2.) jednoho až dvou metrů v intravilánech. Vybrané lokality 

s panelovou zástavbou splňují kritérium střední chyby ve výšce podle tab. 2.1 (v kapitole 

2.1.2). 
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Obrázek 4.26. Rozdílový model                          Obrázek 4.27. Rozdílový model 

ZABAGED - zdokonalený výškopis                  ZABAGED - výškopis 

a LLS na Lochotíně                                             a LLS na Lochotíně 

(přibližné měřítko 1: 1 100)                                (přibližné měřítko 1: 1 000) 
  

 

 

 

 

                                                  
 

Obrázek 4.28. Rozdílový model                         Obrázek 4.29. Rodinné domy  

ZABAGED - zdokonalený výškopis                  na Lochotíně 

a ZABAGED - výškopis na Lochotíně 

(přibližné měřítko 1: 1 100) 
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Obrázek 4.30. Rozdílový model                         Obrázek 4.31. Rozdílový model 

ZABAGED - zdokonalený výškopis                  ZABAGED - výškopis 

a LLS Na Hvězdě                                                a LLS Na Hvězdě 

(přibližné měřítko 1: 1 800)                               (přibližné měřítko 1: 1 700) 
 

 

 

 

                                                               

 

Obrázek 4.32. Rozdílový model                              Obrázek 4.33. Rodinné domy 

ZABAGED - zdokonalený výškopis                       Na Hvězdě 

a ZABAGED - výškopis Na Hvězdě 

(přibližné měřítko 1: 1 800) 

Poznatky týkající se přesnosti ZABAGED (ZABAGED - výškopis a ZABAGED -

zdokonalený výškopis) odpovídá hodnotám uvedeným v kapitole 2.1.2 v tab. 2.1. Dá se říci, 

že hodnoty jsou mnohem lepší.  Výškopis ZABAGED někde ne zcela vystihuje terén, což 

může být způsobeno generalizací a hustotou vrstevnic. Přesnost zdokonaleného výškopisu je 

stejná jako „starého“ výškopisu ZABAGED. Důležitým prvkem doplněným do zpřesněného 

výškopisu jsou terénní hrany. Ve mnou testovaných územích se hrany nevyskytují, nelze tedy 
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očekávat žádné převratné výsledky. Pokud se podíváme na hrany jinde „ve městě“, vyskytují 

se převážně u koryt řek a u železničních těles. 

4.5 Zpracování a vyhodnocení výškových rozdílů nivelačních bodů a dat LLS 

Postup vyhodnocení mezi nivelačními body a body LLS je následující: 

 výpočet výškových rozdílů mezi daty LLS a nivelačními body; 

 výpočet minima, maxima, průměru, sumy, směrodatné odchylky, odchylky a mediánu 

směrodatné odchylky rozdílů výšek bodů LLS a nivelačních bodů; 

 vhodný výběr intervalu výškových rozdílů bez hrubých chyb; 

 odstranění bodů LLS, které nespadají do zvoleného intervalu; 

 výpočet parametrů přesnosti pro okolí nivelačních bodů: 

- systematická chyba (průměr rozdílů výšek)    =∑ ΔH/ ∑ m, 

- náhodná chyba    = √{[( ΔH -   )²]/ [(∑ m) – 1]}, kde „ΔH“ rozdíl výšek bodů LLS     

a nivelačních bodů a „m“ je počet bodů LLS, 

- úplná střední chyba     √(       ); 

 vyhodnocení získaných výsledků. 

Postup je zpracován v programu ArcGIS a v programu Microsoft Office Excel 2007. 

V programu ArcGIS se sloučí vrstva dat LLS s polygonovou vrstvou, která obsahuje                    

v grafické části kruhy o poloměru 5 m a v atributové tabulce k nim přiřazené sloupce 

odpovídajících nivelačních bodů. Všechny úpravy jsou stále uloženy ve vrstvě, která 

obsahuje data LLS. Po otevření atributové tabulky a vytvoří se nový sloupec, do kterého se 

vypočte rozdíl výšek dat LLS a nivelačních bodů (tzn. výšky bodů z dat LLS mínus výšky 

nivelačních bodů). Následně se v atributové tabulce vypočítají hodnoty (minimum, 

maximum, průměr, suma, směrodatná odchylka a odchylka) bodů LLS a nalezne medián   

0,11 m se statistikou výškových rozdílů (viz. obr. 4.34). Zde je patrná přítomnost hrubých 

chyb ve vyhodnocení dat LLS. Minimální výškový rozdíl nyní činní -14,09 m a maximální 

20,01 m. Pro vyloučení hrubých chyb se zavede omezující podmínka, že výškový rozdíl 

nepřesáhne trojnásobek mediánu, tedy 0,32 m. 
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Obrázek 4.34. Statistika výškových rozdílů 

 

Z obr. 4.34 je zřejmé, že normální rozdělení výškových rozdílů má hodně intervalů, přičemž 

nejvíce bodů se vyskytuje v intervalu prostředním a pak četnost bodů prudce klesá. Je to tím, 

že tento graf obsahuje body s hrubými chybami. Nyní se body s hrubou chybou odstraní. 

Pomocí funkce „Select By Atributes“, kterou lze spustit z hlavního menu Selection → Select 

By Atributes, se provede výběr bodů spadajících do uzavřeného intervalu od -0,32 do 0,32 m. 

Jak je vidět z obr. 4.35, do zvoleného intervalu spadá 18204 bodů z 24040 (75,72%). 

 

Obrázek 4.35. Funkce „Select By Atributes“ 

Následně se otočí výběr bodů v atributové tabulce a odstraní se. Každé měření mimo zvolený 

interval by bylo vhodné individuálně posoudit a jeho vyloučení z dalších výpočtů zdůvodnit. 

Protože hromadné automatické zpracování velkého množství měření individuální přístup 

znemožňuje, jsou obvykle měření nesplňující kritérium vyloučena bez dalšího zkoumání i za 

cenu mírného zkreslení výsledků. Nyní mají výškové rozdíly bodů lepší rozložení do 
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intervalů normálního rozdělení (viz. obr. 4.36). 

 

Obrázek 4.36. Statistika výškových rozdílů bez hrubých chyb 

 

Souhrnné výsledky hodnocení přesnosti LLS v okolí nivelačních bodů je možné 

charakterizovat hodnotami systematické chyby    = 0,05 m, náhodné chyby    = 0,13 m           

a úplné střední chyby     = 0,14 m. Tabulky s hodnotami i výpočty jsou pro svou velikost 

pouze na přiloženém DVD ve formátu *.xlsx. Digitálního modelu reliéfu území ČR               

5. generace (DMR 5G) má formu nepravidelné trojúhelníkové sítě bodů (TIN). Finální 

poloautomatické zpracování dat počítá s úplnou střední chybou výšky 0,18 m v odkrytém 

terénu a 0,30 m v zalesněném terénu. Z výše uvedených hodnot je možné nivelační body 

použít pro kontrolu a porovnání dat LLS, ale úplná střední chyba    byla očekávána nižší. 

Tato hodnota může být ovlivněna: 

  nedbalým odečtením výšek čepových značek nad terénem,  

 změnami výšek chodníků v okolí čepových značek, 

 chybné automatické klasifikace bodů LLS. 

Tyto faktory se promítají i do náhodné chyby. Proti zmíněným chybám DMR 5G dosahují 

mnou vypočtené odchylky vysokých hodnot. Co se týká dat LLS odstraněných pro další 

výpočty, jedná se především o body v blízkosti budov (konkrétně v Plzni obchodní centra, 

firemní sklady, budovy ČSAD, kapličky, kostely), zdi Světovaru, tovární zdi závodů Škoda, 

přehradní hráze, výměníky tepla, rekreační domy, transformátorové stanice, stožáry 

elektrického vedení, mosty a lávky. Na špatně vyhodnocené výšky bodů LLS mají vliv různě 

členité střechy (věžičky) objektů, malé duté objekty apod. Samozřejmě tyto objekty nestojí 

izolovaně a na chybách se podílí i jejich nejbližší okolí. 
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5. Závěr 
 

Úkoly, které byly v rámci této diplomové práce kladeny, byly splněny. V práci bylo 

provedeno srovnání výškové přesnosti ZABAGED - výškopis a ZABAGED - zdokonalený 

výškopis. Jako referenční model terénu byla použita data leteckého laserového skenování 

pořízená v rámci Projektu tvorby nového výškopisu území ČR, který právě probíhá. 

Zpřesnění výškopisu ZABAGED v zastavěném území města Plzně nepřineslo prokazatelné 

zlepšení přesnosti výškopisu. Tento závěr se shoduje se závěry podobných diplomových 

prací, které se zabývaly účinností zpřesnění v jiných typech území. Přínosem zpřesnění ale 

jistě bude lepší vystihnutí zejména prvků mikroreliéfu zachycených například formou 

terénních hran. Zjištěná přesnost výškopisu ZABAGED v zastavěném území města Plzně je 

přibližně 0,5 m, což je výrazně lepší, než přesnost uváděná v jiných zdrojích (např. [6]). Jak 

je patrné z obrázků v předchozí kapitole, má ZABAGED v lokalitě Vinice největší změny ve 

tvaru a v poloze vrstevnic. Může to být způsobeno těsnou blízkostí hran, které byly přidány 

do zdokonaleného výškopisu ZABAGED.  

V práci byly dále zjišťovány parametry výškové přesnosti leteckého laserového skenování 

porovnáním s výškami nivelačních bodů. Pro tento účel byla vytvořena databáze nivelačních 

bodů na území města Plzně včetně jejich místopisných údajů. Výsledkem byly hodnoty 

systematické chyby     = 0,05 m a náhodné chyby    = 0,13 m. Vzhledem k tomu, že byla 

použita surová data LLS, lze očekávat, že dalším zpracováním do podoby DMR 5G dojde 

ještě ke snížení systematické chyby. Zjištěné hodnoty nasvědčují tomu, že předpokládané 

parametry výškové přesnosti DMR 5G budou dodrženy. 

Nejlépe jsou vyhodnocované plochy mezi budovami (např. široké silnice). Problémy nečiní 

ani zelené plochy. Vnitrobloky s malými dvorky patří mezi lokality s velkými výškovými 

chybami. To platí pro ZABAGED - výškopis, ZABAGED - zdokonalený výškopis i pro data 

LLS. Nová cesta k získání kvalitního výškopisu z dat LLS je vhodnou metodou, ale budou 

muset být dořešeny odrazy laserových paprsků od členitých střech budov a malých dutých 

útvarů v zastavěných územích (např. nezastřešené věže ve zdech závodů Škoda). 

Data LLS lze kontrolovat v zastavěných lokalitách pomocí nivelačních bodů, avšak musí se 

dávat pozor na hrubé chyby získané chybným odrazem laserových paprsků. V zastavěných 

plochách není ideálním řešením automatická klasifikace, protože je zde mnoho umělých 
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překážek vytvořených lidskou civilizací. V zastavěných lokalitách je vždy třeba zásah 

člověka a opravy výšek dat LLS za pomoci např. ortofot či, pokud to bude nutné, přímo 

pochůzkou po vyhodnocovaném terénu a následné odstranění chyb. 
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Příloha B. Struktura přiloženého DVD 

Zdrojová data    

 LLS 

 Nivelační body 

 ZABAGED - výškopis 

 ZABAGED - zdokonalený výškopis 

Praktická část 

 DMT z dat LLS 

 DMT z dat ZABAGED - výškopis 

 DMT z dat ZABAGED - zdokonalený výškopis 

 Rozdílové modely LLS a ZABAGED - výškopis 

 Rozdílové modely LLS a ZABAGED - zdokonalený výškopis 

 Rozdílové modely ZABAGED 

 Tabulky a výpočty 

 Vybraná území 

Text DP … vlastní text diplomové práce ve formátu PDF 

 


